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Introduction
The IMDI (ISLE Metadata Initiative) Editor was developed at the Max Planck Institute for Psycholinguistics,
Nijmegen, The Netherlands. It is used to create metadata descriptions, both for sessions or resource bundles
and for corpora. As such, it complements the other IMDI tools.

At the moment, the following IMDI tools exist (tools and manuals can be downloaded from http://www.lat-
mpi.eu/tools/imdi/editor/):

• IMDI CV-Editor: a tool for creating lists of controlled vocabulary items;

• IMDI Browser: a tool for displaying and accessing data and metadata;

• IMDI Metadata Search Tool: a tool for searching through metadata information;

• IMDI Tree Builder: a tool for creating browsable trees based on IMDI metadata descriptions (beta
version).

This manual helps you to understand the structure of the IMDI Editor. It consists of the following parts:

1. Navigating through the IMDI Editor (Chapter 1), describing the structure of the IMDI Editor.

2. The IMDI Session Editor (Chapter 2), illustrating the metadata categories used for describing sessions
or resource bundles (i.e., audio/video and written resources).

3. The IMDI Lexicon Editor (Chapter 4), illustrating the metadata categories used for describing lexicon
resource bundles.

4. The IMDI Corpus Editor (Chapter 5), giving step-by-step instructions on how to manage a corpus with
the help of the IMDI Editor.

5. Appendices.

Note

The IMDI Editor has undergone a number of changes since it was first created, both in terms of
its user interface and in terms of the metadata categories supported. If you have metadata files
created with previous versions of the Editor, please consult the following sections: Section 1.6
(for a summary of changes to the user interface, introduced in version 2.0), and Section 2.7
(for a summary of changes to the metadata categories, introduced in version 3.0).

Note

This manual contains a number of references to corpora housed at the Max Planck Institute
(MPI) for Psycholinguistics, Nijmegen. It uses these corpora as a means to illustrate the
functionality of the IMDI Editor. Please 1 note that any remarks only pertain to these corpora.
Corpora stored at other archives or institutes follow different rules.

1. Notation Conventions
The following notation conventions are used:

• Menu items, icons and screen displays are written in the font sans-serif.

• (Shortcut) keys are written in SMALL CAPS.

http://www.lat-mpi.eu/tools/imdi/editor/
http://www.lat-mpi.eu/tools/imdi/editor/


Introduction

vi

• Note

Information on troubleshooting is printed like this.
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Chapter 1. Navigating through the
IMDI Editor

This part of the manual describes the structure of the IMDI Editor.

1.1. The IMDI Editor window
Starting the IMDI Editor opens up the IMDI Metadata Editor (or IMDI Editor) window. Its initial display
is as follows:

Figure 1.1. IMDI Metadata Editor

1. Menu items
2. Browse panel
3. Repository panel
4. Content panel

The IMDI Editor window has the following structure:

• a menu bar (see Section 1.2);

• a Browse panel allowing you to browse through one (or more) IMDI files (see Section 1.3);



Navigating through the IMDI Editor

8

• a Repository panel allowing you to work with recurring information (see Section 1.4);

• a Content panel displaying screens, schemata and fields for entering metadata information (see
Section 1.5).

The size of any of the three panels (Browse, Repository, and Content) can be changed relative to the size of
the other panels. To change its size, do one of the following:

Figure 1.2. Change panel size

1. Use the arrows: Click on an arrow to hide a panel (or to make it visible again).
2. Use the split-pane: Go with the mouse to any split-pane. The mouse will turn into a double-headed

arrow. Click and move that arrow to decrease or increase the size of the panel.

Note

Note: The structure of the IMDI Editor window has changed considerably in version 2.0 (see
Section 1.6 for a summary of the implemented changes). The structure of version 3.0 has only
changed marginally, but there have been a number of changes to the metadata categories (see
Section 2.7 for details).

1.2. The menu items
The menu items are displayed in the top left corner of the IMDI Editor window.

To access any item, do one of the following:

1. Click on the item.

2. Or use the shortcut key ALT plus the underlined letter(s) (e.g., to access the item File > New Session,
press first the keys ALT+F and then N).

3. Or use the shortcut key that is displayed to the right of the corresponding menu item (e.g., to access the
item New Session, press the keys CTRL+N). (This option is only available for some items.)
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4. Or click on the corresponding icon displayed below the menu bar. The following four icons are available:

Figure 1.3. Menu icons
The menu icons from left to right:
a. New Session
b. Open ...
c. Save
d. Information ...

1.2.1. File menu
The File menu is used to create, open, close, save, print and exit IMDI file(s). It contains the following
options:

Figure 1.4. File menu

1.2.1.1. New …

New … allows you to create new IMDI files, and to assign them to a type and a profile (see Section 1.2.3.1
for details).
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Choose first a type (e.g., Resource Bundles (Sessions), Lexicon Resource Bundles, or Corpora) and then
a profile (e.g., Standard (Session) Resource Bundle). Click on the profile, then click on OK. The new file
will be assigned to this type and profile.

Figure 1.5. New File

1. Types
2. Profiles

1.2.1.2. New Session

Click on New Session to create a new IMDI Session file. It will be automatically assigned to the default
profile for Resource Bundles (Sessions) (see Section 1.2.3.1; see Chapter 2).

1.2.1.3. New Lexicon Resource Bundle

Click on New Lexicon Resource Bundle to create a new IMDI Lexicon file. It will be automatically
assigned to the default profile for Lexicon Resource Bundles (see Section 1.2.3.1; see Chapter 3).

1.2.1.4. New Corpus

Click on New Corpus to create a new IMDI Corpus file. It will be automatically assigned to the default
profile for Corpus bundles (see Section 1.2.3.1; see Chapter 5).

1.2.1.5. New Catalogue

Please ignore this option for the moment.

1.2.1.6. New Profile

With this option you can setup a personalized profile, a template for new imdi sessions. See Chapter 3 for
more information on this.

1.2.1.7. Open …

Click on Open to open an IMDI file. Browse to the folder that contains the IMDI file and double-click on
it to open it.

Opening non-imdi files

Of course, you can only open files of the IMDI Editor format. If you try to open a file of a different format,
an error message will appear.
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Opening files from which the original profile was deleted

If you open a file assigned to a profile that has been deleted, the default profile for that type will be used
instead. E.g., you may have an IMDI Session file that was originally assigned to the Sign-Language Profile,
but later on you deleted this profile. If you now open this IMDI Session file again, it will be assigned to the
default profile for session files (e.g., to the Standard (Session) Resource Bundle Profile) (see Section 1.2.3.1
for details).

Opening old IMDI files

If you open a file created with an old IMDI standard, it will be converted to the IMDI 3.0 standard (see
Section 2.7 for details).

Opening broken IMDI files

When the editor opens an IMDI file and there is an error with respect to validation to the IMDI XML Schema
(the "rules" upon which each IMDI file is based), the editor will try to repair the file. First the old IMDI file
is saved with the extension .old.imdi (e.g. myfile.old.imdi) and then the repairs are applied:

Figure 1.6. Repairing broken IMDI files

Note

The repaired file is not automatically saved.

The automatic repair will make it difficult to inadvertently save IMDI files that are not valid with repect
to the IMDI XML Schema.

Sometimes the IMDI file is so severely damaged, e.g. it is not well formed XML or some basic elements are
missing, that it can not be repaired. The editor will warn you when this is the case:

Figure 1.7. File error
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1.2.1.8. Open URI …

Click on Open URI to download an IMDI file from the Web. A dialog window pops up. Enter the
corresponding URI into the window and click on OK (see also Section 1.2.1.6).

1.2.1.9. Open Recent

Go to Open Recent to view a list of the IMDI files that you have recently worked on. Click on any file
from the list to open it (see also Section 1.2.1.6).

1.2.1.10. Close

Click on Close to close the currently active IMDI file (i.e., the file that is highlighted in the Browse panel;
see Section 1.3). All other open IMDI files will remain open.

If the file to be closed has not been saved yet, a warning appears. Click on Yes to save the file before closing;
click on No to not save the file; click on Cancel to return to the file.

1.2.1.11. Close All

Click on Close All to close all IMDI file (see also Section 1.2.1.10).

1.2.1.12. Save

Click on Save to save the currently active IMDI file (i.e., the file that is highlighted in the Browse panel;
see Section 1.3).

If you save an IMDI file for the first time, the Save dialog window appears. Browse to the folder where you
want to save the file, assign a name to it, and then click on Save.

Note

Note: When you save an IMDI file, the IMDI Editor will check if the folder contains a file
named imdi.xsd. If not, it will automatically create this file.

Note

Note for researchers working at the MPI for Psycholinguistics, Nijmegen: The name of the
IMDI file should be the same as the name of the corresponding annotation and media files
(see Section 2.5). The same name should also be entered in the field Session name (see
Section 2.1.1). Furthermore, the file name has to be Unix compatible: do not use file names
longer than 14 characters, do not use non-letter or non-number characters (except for the
underscore: _), and do not use blank spaces.

1.2.1.13. Save As …

Click on Save As to save the currently active IMDI file (i.e., the file that is highlighted in the Browse panel;
see Section 1.3) under a different name (see also Section 1.2.1.12).

1.2.1.14. Save All

Click on Save All to save all open IMDI files (see also Section 1.2.1.12).
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1.2.1.15. Page Setup …

Click on Page Setup … to specify the layout of the printed IMDI file (i.e., paper size, source, orientation,
and margins).

1.2.1.16. Print …

Click on Print … to print the currently active IMDI file (i.e., the file that is highlighted in the Browse panel;
see Section 1.3).

1.2.1.17. Exit

Click on Exit to exit the IMDI Metadata Editor window. All open IMDI files will be closed. If some files
are not yet saved, a warning appears that contains the following kind of information:

Figure 1.8. Save on exit
The dialog window contains a list of all files that are not yet saved. Checkmarks indicate the selected files
(by default, all files are selected). To remove a checkmark (i.e., to deselect a file), click in the box. Click
Select All to select or Deselect All to deselect all files. Click OK to save all selected file. The deselected
files will not be saved. Click on Cancel to return to the Editor window.

1.2.2. View menu
The View menu displays information about the currently active IMDI file (i.e., the file that is highlighted in
the Browse panel; see Section 1.3). It contains the following options:

Figure 1.9. View menu
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1.2.2.1. Information …

Click on Information … to view information about the currently active IMDI file. The following kind of
information is displayed in a panel to the right of the Content panel:

Figure 1.10. Information
The Information tab shows properties of the IMDI file (such as location, size, last modified, IMDI standard
etc.); The tab Prefixes shows the prefixes that are used in the IMDI file (see Section 1.2.3.4); The Validation
tab shows information about whether the file is valid with respect to the XML schema;

1.2.2.2. File Prefixes …

Click on File Prefixes … to view the prefixes that are used in the IMDI file (see Section 1.2.3.4).
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1.2.2.3. Validate File …

Click on Validate File … to view information about whether the file is valid with respect to the XML
schema.

1.2.3. Options menu

The Options menu allows you to set a number of preferences. It contains the following options:

Figure 1.11. Options menu

1.2.3.1. Profile Manager

Every IMDI file is assigned to a type and to a profile. These types and profiles are managed through the
menu item Profile Manager.

By default, there are three different types of IMDI files:

• Resource Bundles or Sessions that are used to describe audio/video and written resources (see Chapter 2);

• Lexicon Resource Bundles that are used to describe lexicon resources (see Chapter 3);

• Corpora that are used to describe larger corpora (see Chapter 5).

Types are associated with one or more profiles. These profiles specify the available metadata categories
together with their constraints. For example, members of the sign language research community have
developed a Sign-Language Profile. IMDI files that are based on this profile contain some sign-language-
specific metadata categories and constraints, e.g.:
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Figure 1.12. Sign-language-specific metadata categories

1. IMDI files based on the Sign-Language Profile contain the metadata category Speaker/Signer.

2. This Speaker/Signer category contains keywords that are of relevance to sign-language research (e.g.,
Deafness.Status etc.). For each keyword, there are constraints on its values. These constraints are
visualized in the form of pull-down menus of controlled vocabulary items (e.g., hearing, hard-of-
hearing etc.).

To manage types and profiles, click on Profile Manager. The following options are available:

• Add a new profile:

Click on the type where you want to add the profile. Then click on Add (to add a locally-stored file) or
on Add URL (to add a file stored on the Web). A dialog window appears, allowing you to browse to the
file or to enter its URL.
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Figure 1.13. Profile Manager

• Delete a profile:

Click on the profile that you want to delete. Then click on Delete.

• Select the default profile for a type:

Click on the profile that you want to make the default profile for a type. Then click on Make Default.
From now on, this profile will automatically be used whenever you create a new IMDI file based on
this type, i.e., for new Session files (see Section 1.2.1.2), new Lexicon files (see Section 1.2.1.3) or new
Corpus files (see Section 1.2.1.4). The non-defaults can still be accessed through the menu item File >
New … (see Section 1.2.1.1).

Click on OK to exit the Profile Manager window again.

Note

Profiles are stored in the folder <user-directory> \ IMDI-TOOLS \ Profiles
\ local). For the moment, profiles have to be programmed by hand. In future versions of
the IMDI tools, it will be possible to create profiles with the help of the IMDI Editor.

1.2.3.2. Anonyms …

Anonyms … is used whenever you have chosen to make the name of an actor anonymous, i.e., whenever
you have chosen that the actor’s real name should only be visible to you. If someone else opens the IMDI
file, a code will be displayed in the name fields. This is the case for both the Name and Full Name field.

The option Anonyms … allows you map a full name to such a code. This mapping will be stored in a file
on your computer. You (and everybody whom you grant access to this file) will be able to see the full name,
while everybody else will only see the code.

To create such a file, do the following:

1. Click on Options.

2. Click on Anonyms ….

The Anonyms overview dialog window appears. It allows you to create, modify and remove mappings,
and it displays all available mappings, e.g.:
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Figure 1.14. Anonyms overview dialog window

The following options are available:

• You can sort the available mappings. Click on any of the column headers to sort the corresponding
column alphabetically.

• To add a mapping, click on Add …. The Anonyms input dialog window appears. Please fill in the
institute (e.g., MPI), the project (e.g., Goemai), the code of the actor and his/her full name.

Figure 1.15. Anonyms input

To save the mapping, click first on Apply and then on Close.

The new mapping will be displayed in the Anonyms overview dialog window.

Note

The column User (in the Anonyms overview dialog window) does not appear in the
Anonyms input dialog window. This column is automatically filled in by the program.
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• To edit a mapping, click on it to highlight it. Then click on Edit …. The Anonyms input dialog window
appears and displays the highlighted mapping. Type in your changes.

Figure 1.16. Anonyms input: edit

Click on OK to save the changes.

• To remove a mapping, click on it to highlight it. Then click on Remove. The mapping is removed
without further warning.

3. Click on Close to exit the Anonyms overview dialog window.

All mappings are saved in the file user-name.ano in the folder <user-directory> \ IMDI-
TOOLS \ Anonyms, e.g.:

Figure 1.17. Anonyms mapping file

If you want other people to have access to these mappings, send them a copy of the file user-
name.ano. They should then save this file in their folder <user-directory> \ IMDI-TOOLS
\ Anonyms.

In order to use this anonymization feature, be sure to enter the full name into the Name and/or the Full Name
field. The IMDI editor automatically will ensure that only you will have access to it. Others will see the
code you provided.

Note

Don’t enter the code name into the Name or Full Name fields in the actor screen. If you do
so, the real name will not be connected to this code. However, for your own convenience you
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might want to enter the code name into the actor’s Code field. This way you can see directly
the link between the Code and the Full Name without opening the anonymization window.

With anonymization codes available Without anonymization codes available

1.2.3.3. Vocabularies …

The IMDI tools make use of so-called "controlled vocabularies" to ensure consistency across users (i.e., they
provide lists of values for specific metadata categories or keys). These vocabularies are stored on the Web,
and a copy of them is stored in the cache of your desktop computer (in the folder <user-directory>
\ IMDI-TOOLS \ CVCACHE) (see the IMDI CV-Editor manual for details).

You can view these vocabularies through the menu item Vocabularies …. Click on it to access the Vocabs
overview window, e.g.:

Figure 1.18. Vocabs overview
Columns:

1. Name: the name of the metadata category;
2. Tag: the tag of the metadata category (if it is in a language other than English);
3. CV URL/Local Path: the name and URL / local path of the controlled vocabulary file;
4. Local: an indication of whether or not the file is stored locally;
5. Description: descriptive information about the controlled vocabulary;
6. Language: the language of the metadata category and its vocabulary.

The Vocabs overview window offers you the following options:
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• You can sort the available controlled vocabularies. Click on any of the column headers to sort the
corresponding column alphabetically.

• Add File …

Click on Add File … to add a controlled vocabulary file that is stored locally. The Browse window
appears, allowing you to browse to the folder and to select the file. The vocabulary will then be added
to the Vocabs overview window.

• Add URL …

Click on Add URL … to add a controlled vocabulary file that is stored on the Web. The Vocab add
window appears. Enter the URL of the vocabulary, click on Apply and then click on OK. The vocabulary
will be added to the Vocabs overview window.

Figure 1.19. Vocab add

• Read cache

Click on Read cache to view all available controlled vocabularies (i.e., all vocabularies that are stored
in the folder <user-directory> \ IMDI-TOOLS \ CVCACHE).

• Refresh selected

Click on a vocabulary to select it, then click on Refresh selected to have the IMDI tools check for a
newer version of that vocabulary on the Web, and to update the cache accordingly.

• Refresh all

Click on Refresh all to have the IMDI tools check for newer versions of all vocabularies on the Web,
and to update the cache accordingly.

• Show entries …

Click on a controlled vocabulary to select it, then click on Show entries … to view its content., e.g.:
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Figure 1.20. Show entries
1. Click on a vocabulary to select it;

2. Click on “Show entries …
3. Content is displayed

• Close

Click on Close to close the Vocabs overview window.

1.2.3.4. Create Update StyleSheet

A stylesheet offers the possibility to make changes to multiple imdi-files at once. It resembles a kind of
powerful find-and-replace option. Using an update stylesheet requires 2 steps:

• creating the stylesheet, which can be done with the IMDI editor

• applying the prepared stylesheet on a set of imdi-files with the IMDI browser

For information about the latter process, see the IMDI browser manual, Chapter 4.

Please be aware that this is a powerful technique that should be used with care as it has the potential (if
used in an inappropriate way) to damage a large set of IMDI files! Although a backup will be made of all
files before they are alterered, it is a good practice to think twice before you apply a stylesheet.

To create an update stylesheet choose Options > Create Update StyleSheet. At the right side of the
window an extra frame will appear:
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Figure 1.21. Create Update Stylesheet

For every field in a session file, you can specify a conditon and/or a modification:

• If you enter both, then the stylesheet will act as a find-and-replace function.

• If only a modification is entered this value will replace the data of the chosen text field, without considering
its previous content. The New Key Element option creates a new key-value pair (see Section 2.4.1.6)
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• If the modification is omitted, the condition will act as a restriction on the set of files upon which the
other modifications will be performed.

• If you specify multiple conditions, they all need to be fulfilled before the modifications are applied.

If you specify multiple conditions, they all need to be fulfilled before the modifications are applied.

Note

In version 3.2 you can modify 1 key at most for every style sheet.

An example

Let’s say we want to change the content part of a set of metadata files. Every time we encounter both the
genre 'Literature' and the subgenre 'Novel', we can assume the associated modality will be 'writing'. So in
this case we will use 'Literature' and 'Novel' as conditions, while 'writing' acts as the modification.

Figure 1.22. Example Update Stylesheet: 1

1. Click in the text field for which you want to specify acondition

2. Tick the condition check box and enter "Literature"

or use the < button to copy the text from the selected text field
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Figure 1.23. Example Update Stylesheet: 2

3. Now do the same for Subgenre and "Novel"

4. The description box shows the specified conditions

Note

to specify a condition for a field that is constrained by a closed controlled vocabulary, select
a value from the dropdown box in the editor itself. This selection will appear as grey text in
the stylesheet editor.
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Figure 1.24. Example Update Stylesheet: 3

5. Now tick Modification
6. Enter "writing"
7. Click on Generate Stylesheet

Figure 1.25. Example Update Stylesheet: 4

8. Enter a name for this stylesheet
9. Click on OK
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After you saved the newly created stylesheet, take a look at Chapter 4 of the IMDI browser manual for
instructions about how to apply it to your files.

1.2.3.5. Preferences…

Click on Preferences … to access the Preferences dialog window.

In the Preferences dialog window, the following four options are available:

1. Prefixes

2. Resources

3. Update Policy

4. Font

5. User interface

Figure 1.26. Preferences

Click on any of the headings in the left panel to activate the corresponding option.
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Prefixes

This option allows you to specify the path to the different types of files (see Chapter 5 for details).

Resources

This option allows you to specify the browse options (see Chapter 5 for details).

Update Policy

The IMDI tools make use of so-called "controlled vocabularies" (see Section 1.2.3.3). These vocabularies
are stored on the Web, and a copy of them is stored in the cache of your desktop computer (in the folder
<user-directory> \ IMDI-TOOLS \ CVCACHE). The Web version is changed sometimes, but
the IMDI tools will continue to use the locally-stored version until the cache is updated again. By default,
the cache is updated whenever you run an IMDI tool. However, you can change this policy, and determine
if and when the vocabularies should be updated.

Click on Update Policy to determine this policy. The following options are available:

Figure 1.27. Update policy

Font

This option allows you to display special character sets and fonts. To select a set and a font, do the following:
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1. Under Unicode Block (in the left panel), select a unicode block by clicking on it. The available fonts are
then displayed under Font (in the right panel).

2. Under Font, select a font by clicking on it.

3. Click on OK to implement the new font.

Figure 1.28. Font

User Interface

Remove the checkmark before Show ToolTip Boxes to disable the online floating help boxes when editing
a text field.
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Figure 1.29. Show Tooltip Boxes

1.2.4. Help menu

Click on Help > About IMDI MD Editor ... to view information about the IMDI Editor, e.g.:
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Figure 1.30. About IMDI MD editor

1.3. The Browse panel
The Browse panel allows you to browse through one (or more) IMDI (Session, Lexicon or Corpus) files.
It displays all currently open IMDI files, e.g.:
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Figure 1.31. Browse panel

1. IMDI Session files (with the currently active node highlighted in blue)
2. Internal structure of an IMDI Session file
3. IMDI Corpus file and its internal structure

The Browse panel makes use of the following icons:

•

session node (corresponding to an IMDI Session or Lexicon file, see Chapter 2 and Chapter 3)

•

corpus node (corresponding to an IMDI Corpus file, see Chapter 4)

•

metadata node

•

media file node

•

written resource (or "transcription") file node

•

lexicon node

•

corpus link node
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Under each session or corpus node, the structure of the corresponding IMDI (Session, Lexicon or Corpus)
file is displayed in the form of metadata nodes, media files nodes, written resource file nodes, lexicon file
nodes and/or corpus link nodes.

The nodes of the Browse panel interact in the following ways with the screens of the Content panel (see
Section 1.5):

1. Click on any node in the Browse panel to make the corresponding IMDI file the currently active IMDI
file. It will be highlighted in blue color, and its metadata information will be displayed in the Content
panel, e.g.:

Figure 1.32. Open a node
1. Browse panel: Project node of the file TreesSM.imdi

2. Content panel: Project screen (of the file TreesSM.imdi)

2. Some nodes in the Browse panel allow you to add further sub-nodes, which are then displayed as screens
in the Content panel. For example, the node Actors allows you to add a sub-node for each actor. To add
a sub-node, do one of the following:
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Figure 1.33. Add subnodes (1)
1. Click with the right-mouse button on a node. A pull-down menu appears. Select Add from the pull-

down menu.

2. Alternatively, click on the Add button in the Content panel.

Figure 1.34. Add subnodes (2)
3. The added subnode is displayed in the Browse panel and metadata of the new subnode is displayed

in the Content panel.
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Figure 1.35. Add subnodes (3)
4. When a name is entered in the Name field, it is also displayed as the name of the new subnode in

the Browse panel.

You can insert the new sub-node anywhere under an appropriate top node. To select its position, do one
of the following:

• Add the sub-node (see above), and click on it in the Browse panel, keep the mouse button clicked
and drag it to its new position. A line will appear at this position. Release the mouse button, and the
sub-node will be inserted in its new position, e.g.:

Figure 1.36. Drag a subnode

• Alternatively, do the following:
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Figure 1.37. Add a subnode in Content panel
1. In the Content panel, click on the subnode before which you want to insert the new subnode. It

is highlighted in blue.
2. Click on Add.
3. The new subnode is added before the selected subnode.

Note

The IMDI Editor makes use of different Add buttons for different purposes, and not all
of them add new sub-nodes. This function is only available for those nodes that allow
for the three options Add …, Edit …, and Remove.

3. Added sub-nodes can be removed again. Do one of the following:

In the Browse panel, click on the sub-node that you want to remove. It will be highlighted in blue color.
Then click with the right-mouse button on the highlighted node. A pull-down menu will appear. Select
Remove from the pull-down menu.

Alternatively, in the Content panel, click on the sub-node that you want to remove. Then click on the
Remove button.

Copying a node

The information of an existing node can be copied to a new node with drag and drop. Do the following:

• Click on a node in the Browse panel

• Hold down the left mouse button and drag the node a bit

• Now hold the CTRL key (make sure you already dragged the node a bit)

• Move the node to a parent node
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• Release the left mouse button

Figure 1.38. Copying a node

1.4. The Repository panel
The Repository panel allows you to work with recurring metadata information. Such information is entered
once into the Content panel (see Section 1.5), and is then stored in the Repository panel for future usage.

For example:
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Figure 1.39. The repository panel

1. The information about the language GOEMAI is entered into the Content panel.

2. This information is then stored in the Repository panel.

Note

The repository is stored under the name local.repository.xml in the folder <user-
directory> \ IMDI-TOOLS \ SDRCache. The files that contain the actual metadata
information are automatically assigned a name and are then stored in the same directory, e.g.:
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Figure 1.40. Location of the local repository

1. The local repository.

2. An example of a file that stores metadata.

The Repository panel displays a number of buttons and a pull-down menu (which is accessed by clicking on
a node, first with the left mouse button to select it and then with the right mouse button to open the pull-down
menu). The buttons and the pull-down menu are used for the following purposes:

• Storing metadata information in the repository (see Section 1.4.1).

• Deleting metadata information from the repository (see Section 1.4.2).

• Managing the structure of the repository (see Section 1.4.3).

• Exporting nodes from the repository (see Section 1.4.4).

• Importing nodes into the repository (see Section 1.4.5).

• Updating the information in the repository (see Section 1.4.6).

• Using metadata information from the repository (see Section 1.4.7).

1.4.1. Storing metadata information in the repository

To store metadata information in the repository, do one of the following:

• Drag and drop a node from the Browse panel to the appropriate node in the Repository panel. For example,
to add the language GOEMAI to the repository, do the following:



Navigating through the IMDI Editor

40

Figure 1.41. Store in repository: drag and drop
1. Click on the node in Browse panel.
2. Keep the mouse button clicked and drag it to the appropriate node in the Repository panel.
3. Release the mouse button. The node is added to the repository.

• Alternatively, make use of the Get Data option in the Repository panel. For example, to add the actor
J to the repository, do the following:

Figure 1.42. Store in repository: Get Data
1. Click on the sub-node in Browse panel.
2. Click on the appropriate top node in the Repository panel.
3. Make use of the 'Get Data' option: (a) Either click on the Get Data button, or (b) right-click on the

highlighted node, and then click on the Get Data item in the pull-down menu. In both cases, the node
is added to the repository.
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Note

You can only add a sub-node from the Browse panel to an appropriate corresponding top node
in the Repository panel, e.g., a language can only be added to a language-type node, and an
actor can only be added to an actor-type node. If the two nodes (of the Browse and Repository
panels) do not match, the program will automatically disable the Drag and drop and the Get
Data functions.

1.4.2. Deleting metadata information from the
repository

To delete metadata information, do the following:

• In the Repository panel, click on the node that you want to delete. The node will be highlighted in blue
color.

• Click with the right mouse button on the highlighted node. A pull-down menu appears.

• In the pull-down menu, click on Delete. After a warning, the highlighted node is deleted.

1.4.3. Managing the structure of the repository
The following two management options are available:

• Add a new repository group. Do the following:

Figure 1.43. Add a repository group
1. Right-click on the node where you want to add the new group and select New Group.
2. Enter the name of the new group and click OK. The group will automatically be assigned to the right

type/node.
3. The new group is added to the repository.



Navigating through the IMDI Editor

42

• Rename a repository group. Do the following:

Figure 1.44. Rename a repository group
1. Right-click on the node that you want to rename and select Rename Group.

2. Enter the new name and click OK.

3. The group is renamed.

• Rename an item:
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Figure 1.45. Rename an item
1. Right-click on the node that you want to rename and select Rename.

2. Enter the new name and click OK.

3. The item is renamed.

1.4.4. Exporting nodes from the repository

You can export a node from the repository. Do the following:

1. Click on the node that you want to export. It will be highlighted in blue color.

2. Make use of the Export options:

a. Either click on the Export button, e.g.:
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Figure 1.46. Export button

b. Or right-click on the highlighted node, and then click on the Export item of the pull-down menu, e.g.:

Figure 1.47. Right click and Export

The Export Repository dialog window appears.

3. Give the name and location of the file that should contain the exported node. Then click on OK (or press
the key ENTER).

Figure 1.48. Repository name
a. Enter a name.

b. Browse to the location.

c. Click on OK.
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The file is saved in the specified folder. Furthermore, the exported repository is displayed as an additional
node in the Repository panel, e.g.:

Figure 1.49. Result of export
a. The files are saved in the specified folder.

b. The exported file is add to the Repository panel.

1.4.5. Importing nodes into the repository

You can import a node into the repository. In this case, the IMDI Editor creates a copy of the original file
and stores this copy in the folder <user-directory> \ IMDI-TOOLS \ SDRCache.

Note

If you have old templates that were created with an earlier version of the IMDI Editor (i.e.,
earlier than version 2.0), you need to import them into the Repository panel.

To import a node, do the following:

1. Make use of the Import options:

a. Either click on the Import button, e.g.:
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Figure 1.50. Import button

b. Or right-click somewhere in the Repository panel, and then click on the Import item of the pull-down
menu, e.g.:

Figure 1.51. Right click and Import

The Import Repository dialog window appears.

2. Browse to the file that contains the repository, and click on OK.
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Figure 1.52. Browse to repository file

The file is displayed as an additional node in the Repository panel, e.g.:

Figure 1.53. Imported repository

1.4.6. Updating the information in the repository

This option allows you to update an imported repository (i.e., the copy of the file, see Section 1.4.5) after
the original file has been modified.

Do the following:

1. Click on the imported repository. It will be highlighted in blue color.

2. Right-click on that repository. A pull-down menu appears.

3. Click on Update. The information in the repository is updated.

1.4.7. Using metadata information from the repository

To use metadata information from the repository, do one of the following:

• Drag and drop a sub-node from the Repository panel to the appropriate top node in the Browse panel.
For example:
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Figure 1.54. Drag and drop from repository
1. Click on the sub-node in the Repository panel.

2. Drag the sub-node to the appropriate top node in the Browse panel, and drop it.

3. The information is entered into the Content panel.

• Make use of the Put Data option in the Repository panel. For example, to insert information about access
rights, do the following:
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Figure 1.55. Put Data from repository
1. Click on the subnode in the Repository panel.

2. Make use of the 'Put Data' option: (a) Either click on the Put Data button or (b) right-click on the
highlighted node, and then click on the Put Data item in the pull-down menu.

3. The information is entered under the appropriate node.

Note

You can only insert information into the appropriate corresponding node of the Browse panel
(and the corresponding screen of the Content panel), e.g., information about an actor can only
be inserted in the Actors node of the Browse panel (and the screen Actors of the Content panel).
If a non-matching node is active in the Browse panel, the program will automatically disable
the Drag and drop and the Put Data functions.

Note

You can add a group of nodes to the Browse panel, e.g., a group of actors. In this case, you
have to drag and drop or 'put' the higher node from the Repository panel into the Browse panel
(e.g., the node Actors).
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Note

You can overwrite an exiting node by dragging a node from the Repository panel onto a node of
the Browse panel (e.g., by dragging actor X onto the node actor Y). In this case, the following
warning will appear:

Figure 1.56. Corfirm Replacement

Click Yes if you want to replace the node, otherwise click No.

1.5. The Content panel
The Content panel displays the screens (see Section 1.5.1) and the schemata and fields (see Section 1.5.2),
which are used for entering metadata information. And it allows you to specify links to media, written
resources, lexicon, info and metadata files (see Section 1.5.3).

After you have entered metadata information, you can choose to view this information either in the IMDI
Editor format (the default view) or as an HTML document. Click on the buttons at the top of the Content
panel to switch between the two views.

Figure 1.57. Editor View and HTML View
IMDI Editor view (left) and HTML View (right)

1. Click here to switch between the two views.
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1.5.1. Screens

The Content panel displays a number of screens. The following main screens are available:

IMDI Session Editor (see Chapter 2) and IMDI Lexicon Editor (see Chapter 3):

• Session

general information about the session (see Section 2.1);

• Project

information about the project within which the session data was collected (see Section 2.2);

• Content

information about the content of the session (see Section 2.3);

• Actors

information about the actors participating in the session (see Section 2.4);

• Resources

information about written resource files, media files, and non-digital sources associated with the session
(see Section 2.5), or about lexicon files (see Section 4.1);

• References

cross-references to any material that is relevant to the content of the session (see Section 2.6).

IMDI Corpus Editor (see Chapter 5):

• Corpus

links to IMDI Session, IMDI Lexicon and IMDI Corpus files.

These main screens are accessed through clicking on the corresponding node in the Browse panel (seealso
Section 1.3).
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Figure 1.58. Opening corresponding screens

1. Browse panel: Project node of the file TreesSM.imdi

2. Content panel: Project screen (of the file TreesSM.imdi)

The IMDI Editor screens are structured in the following ways:

• All screens display schemata and fields into which the metadata information is entered (see Section 1.5.2).
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Figure 1.59. Screens structure
1. Schema

2. Fields

3. Subscreen headers

• Some screens contain sub-screens that are displayed like filing cards. These sub-screens give access to
additional schemata and fields.

• Some screens have Add … buttons (and corresponding Remove and Edit … buttons) that allow you to
enter multiple types of information of the same kind, e.g., one sub-screen added for each language spoken
by an actor. These additional sub-screens are then displayed as separate sub-nodes in the Browse panel
(see also Section 1.3), e.g.:

Figure 1.60. Subscreens
1. 3 sub-screens displaying 3 languages

2. To add a new sub-screen, click on Add ….

To modify a subscreen, click on it to highlight it, and then double-click on it, or click on Edit ….

To remove a sub-screen, click on it to highlight it, and then click on Remove
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There are two options for navigating through the Content panel:

1. You can use the mouse: click with the mouse into a field (to enter information), on a sub-screen header
(to activate the corresponding sub-screen) or on a button (to execute the corresponding command).

2. Alternatively, you can use the following shortcut keys.

• Press TAB to move to the next field or button.

• Press SHIFT+TAB to move to the previous field or button.

• When a button is highlighted, press SPACE to execute the corresponding command.

• Press the left or right arrow key to move from sub-screen to sub-screen header.

1.5.2. Schemata and fields
Screens are made up of different units, so-called 'schemata'. Each schema contains a number of boxes into
which the actual information is entered. These are called 'fields', e.g.:

Figure 1.61. Schemata and fields

1. Schemata
2. Fields

Most of the fields are more or less standardized1. The following symbols and options are available:

'closed controlled vocabulary' You can enter only one value, and
this value must be selected from
the pull-down menu.

'closed controlled vocabulary list' You can enter more than one value
(separated by commas), but all
values must be selected from the
pull-down menu.

'open controlled vocabulary' You can select one value. You
can either select this value from
the pull-down menu or type in an
alternative value.

Please see the document IMDI Metadata Elements for Session Descriptions under http://www.mpi.nl/IMDI/ for updated lists of controlled
vocabularies, their values and their definitions.

http://www.mpi.nl/IMDI/
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'open controlled vocabulary list' You enter more than one value
(separated by commas). You can
either select these values from
the pull-down menu or type in
alternative values.

In all four cases above, you can choose a value directly from the pull-down menu. Alternatively, you can
start typing, in which case the pull-down menu will automatically open to display the available values.

'constrained format' The value must be entered in a
certain format (e.g., a date must be
entered in the format YYYY-MM-
DD). As soon as you start typing,
the format is displayed in the field
(highlighted in blue color). Please
type over this format.

For all fields, there are tool-tips available. Point with the mouse to the label of the metadata category and
leave it there for one second. The tool-tip appears, giving you information about this category, e.g.:

Figure 1.62. Tooltip

1. Point with the mouse to the category label and leave it there for one second.

2. The tool-tip appears.

In addition to these standardized fields, the IMDI Editor allows for the possibility to enter project-specific
information. Such information is entered into a Keys schema (see Section A.2 on instructions of how to fill
in a Keys schema), e.g.:
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Figure 1.63. Project specific data
Project-specific keywords for the actor J

Note

It is possible to use (project-specific) controlled vocabularies in a Keys schema, i.e., to have
a Keys schema display a pull-down menu containing predefined values. See Section A.2 for
details.

In addition to the standardized fields and the keyword fields, there are Descriptions schemata (see
Section A.1 on instructions of how to fill in a Descriptions schema). Such a schema contains a prose
description that could serve as a reminder (to you or others) of the circumstances of data collection.

1.5.3. Links

In addition to the information that you enter directly into an IMDI file, you can create links to other files, i.e.,
to media files (see Section 2.5.2), written resource files (see Section 2.5.3), lexicon files (see Section 4.1),
info files (see Appendix A) and other IMDI files (see Chapter 5). Such links are specified in the IMDI file
itself, and the corresponding files can then be accessed through the IMDI Browser, e.g.:
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Figure 1.64. Links

1. Metadata information that is entered directly into an IMDI file is displayed in the “Info/Content” and
“Description” panels of the IMDI Browser.

2. Links are displayed as additional nodes in the IMDI Browser (and can be accessed through double-
clicking on them).

Note

Note for researchers working at the MPI for Psycholinguistics, Nijmegen: Please specify only
the name of such a file – do not make use of the open folder icon to the right of the Link field.

1.6. Changes to the user interface (version
2.0)

The following changes to the user interface of the IMDI Editor were implemented in version 2.0:

Version 2.0 Functionality corresponding item in
Version 1.5 (and earlier)

displays all currently open files Windows menu itemBrowse panel

displays the internal structure of an
IMDI file

screen headers

Repository panel stores recurring information templates
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Chapter 2. The IMDI Session Editor
This part of the manual guides you through the metadata categories of the IMDI Session Editor, as defined
in the IMDI 3.0 standard. Note that the IMDI Editor also allows you to create project-specific profiles,
containing additional categories. However, these additional categories are entered into Keys schemata, and
they do not form part of the IMDI 3.0 standard (see Section 1.2.3.1 for details on profiles; and see Section A.2
for details on Keys schemata). They are thus not discussed in this section.

The IMDI Session Editor creates IMDI Session files (*.imdi) that describe audio/video and written

resources. Each file describes a single unit, termed 'session' or 'resource bundle'1. This unit usually
corresponds to a meaningful unit of analysis, e.g., to a piece of data having the same overall content, the
same set of actors, and the same location and time (e.g., one elicitation session on topic X, or one folktale,
or one ‘matching game’, or one conversation between several speakers).

Every session or resource bundle consists of one metadata file (i.e., an IMDI Session file) plus an unlimited
number of other resources (i.e., media files, annotation or written resource files, and/or info files). The
metadata file contains all the information that is entered into the metadata categories – categories that are
displayed in the form of screens, schemata and fields in the Content panel of the IMDI Editor (see also
Section 1.5), e.g.:

Figure 2.1. Screens, schemata and fields

1. Screens displayed in the form of nodes in the “Browse” panel.
2. Schemata.
3. Subscreens.
4. Fields.

Throughout the manual, these two terms are used interchangeably, with ‘session’ being the preferred term for audio/video resources, and
'resource bundle' for written resources.
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The following sections illustrate the purpose of the various screens, schemata and fields. It is organized on
a screen-by-screen basis, following the structure as it is displayed in the Browse panel:

• Session (see Section 2.1);

• Project (see Section 2.2);

• Content (see Section 2.3);

• Actors (see Section 2.4);

• Resources (see Section 2.5);

• References (see Section 2.6).

When entering information into the IMDI Editor, please keep the following points in mind:

1. What kind of information would you want to search for? Make sure that such information is entered into
standardized fields or Key schemata.

2. All information entered on a screen is only relevant to that screen. This point is especially important
for recurring schemata such as Descriptions, Keys, Language, or Access. These schemata occur on a
number of different screens, and although they always look the same, they ask for different information
– information that is relevant to the corresponding main screen.

3. Remember to make use of the Repository panel to store recurring information (see Section 1.4).

Note

Note for researchers working at the MPI for Psycholinguistics, Nijmegen: The metadata
information entered into the IMDI Editor is meant to be visible to the outside world via the
Web. This only concerns the metadata information – not the audio, video and annotation files.
But please be aware that other people will have access to your metadata files. Keep this in mind
when you enter metadata information into the Editor, and make sure to exclude all sensitive
information.

2.1. Session
This screen contains general information about the session or resource bundle. All the information that is
entered into the Session screen will be displayed in the IMDI Browser in the following way (see the IMDI
Browser manual for details):
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Figure 2.2. Session displayed in the IMDI browser

1. Information under Session and Descriptions is displayed under the session node itself.

2. Information under Location and Keys is displayed under the nodes Location and Keys.

2.1.1. Session

The name, title and recording date of the session. For example:

Figure 2.3. Session



The IMDI Session Editor

61

Session Name

A short name or abbreviation that uniquely identifies the session.

Note

Note for researchers working at the MPI for Psycholinguistics, Nijmegen: This name should
be the same as the name of the IMDI file (see Section 1.2.1.12) and as the name of the
corresponding annotation and media files (see Section 2.5). Furthermore, the file name has to
be Unix compatible: do not use file names longer than 14 characters, do not use non-letter or
non-number characters (except for the underscore: _), and do not use blank spaces.

Session Title

The complete title of the session. Usually, it is the spelled-out version of the abbreviated Session Name.

Recording Date

The date at which the session data was collected. The date has to be entered in the format YYYY-MM-
DD. Once you start typing into this field, the IMDI Editor will automatically display the required format
(highlighted in blue color). Type over it to enter the date.

2.1.2. Descriptions

A description of the circumstances under which the data was collected.

Whenever you access a session through the IMDI Browser, this description is the first piece of information
that you will see. It should therefore contain all the information that is necessary to quickly remind you about
this session. However, it should not contain an elaborate description of the content (reserve this information
for the Content screen, see Section 2.3.2). E.g.:
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Figure 2.4. Descriptions

1. Language in which the description is written, e.g., English

2. Description in English

See Section A.1 for instructions on how to fill in a Descriptions schema. Remember: The field Language
refers to the language in which the description is written – not to the language under investigation.

2.1.3. Location

The location at which the data was collected. For example:
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Figure 2.5. Location

Continent

The continent where the data was collected. Choose the continent from the pull-down menu, or type it in. It
is a 'closed vocabulary', i.e., only values listed in the pull-down menu are accepted by the IMDI Editor.

Country

The country where the session data was collected. Choose the country from the pull-down menu, or type it
in. It is a 'closed vocabulary', i.e., only values listed in the pull-down menu are accepted by the IMDI Editor.

Address

The address where the session data was collected (e.g., at school XY).

Region

The region (province, town, suburb, etc.) where the session data was collected. To add a region, click on the
Add button; to remove a region, click on it to highlight it and then click on the Remove button.

2.1.4. Keys

Keywords that are relevant to (a) the collection of the data and (b) the creation of the IMDI file. For example:
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Figure 2.6. Keys

1. The person who created the IMDI file

2. Screens of the IMDI file that are not yet filled in.

3. Things that need to be checked (e.g., a lost file).

See Section A.2 for instructions on how to fill in a Keys schema.

2.2. Project
This screen contains information about the project within which the session data was collected. All the
information that is entered into the Project screen will be displayed in the IMDI Browser in the following
way (see the IMDI Browser manual for details):
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Figure 2.7. Project displayed in the IMDI browser
Information under Project is displayed under the node Project.

Enter the information into the IMDI Editor as follows:
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Figure 2.8. Project

1. Short name for the project.
2. Full title of the project.
3. Project identifier (if any).
4. Person / institution responsible for the project.
5. Description of the project.

Name
A short name or abbreviation that uniquely identifies the project.

Title
The full title of the project.
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ID

A unique identifier for the project (if any), e.g. 'IST-1999-10651'.

Contact Information

Contact information about the person or institution responsible for the project (the Name, the Address, the
E-mail address and the Organisation he/she belongs to).

Descriptions

A description of the scope and goals of the project. See Section A.1 for instructions on how to fill in a
Descriptions schema. Remember: The field Language refers to the language in which the description is
written - not to the language under investigation.

2.3. Content
This screen contains information about the content of the session. All the information that is entered into
the Content screen will be displayed in the IMDI Browser in the following way (see the IMDI Browser
manual for details):



The IMDI Session Editor

68

Figure 2.9. Content displayed in the IMDI browser

1. Information under Descriptions is displayed under the Content node itself.

2. Information under Content Type is displayed under the nodes of each category (e.g., Task, Modalities
etc.).

3. Information under Languages and Keys is displayed under the nodes Languages and Keys.

2.3.1. Content Type

Information about the genre, the task, the modalities, the subject, and the communication context. For
example:
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Figure 2.10. Content type

Many of the fields under Content Type offer predefined values that are displayed in the form of pull-

down menus2: some of them only accept values from the pull-down menu, while others allow you to enter
alternative values (see below). Furthermore, it is sometimes possible to enter more than one value – in this
case, please separate the values with a comma. See Section 1.5.2 for the different options and how they are
symbolized in the IMDI Editor.

Genre and Subgenre

Information about the genre and the subgenre, whereby Subgenre is dependent on Genre. I.e., the value
that you enter under Genre will determine the values that are available under Subgenre. Both Genre and

Please see the document IMDI Metadata Elements for Session Descriptions under http://www.mpi.nl/IMDI/ for updated lists of values and
their definitions.

http://www.mpi.nl/IMDI/
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Subgenre are 'open vocabularies', i.e., you do not have to select a value from the pull-down menu, but can
enter an alternative value instead. The following values have been suggested:

• Genre

– Subgenre (Example)

• Discourse

– Narrative (a folktale, a historical narrative, a personal experience narrative)

– Oratory (a summing-up speech by a legal counsel, a political speech, a church sermon)

– Procedural (a recipe, an instruction on how to build a house)

– Formulaic (proverbs, greetings/leavetakings)

– Language Play (riddles, humor)

– Interview

– Conversation

– Description (a description of the layout of a compound)

– Unintelligible speech

• Ritual/religious texts (a prayer, a healing ritual, a catechism)

• Fiction (a detective novel, a science fiction story)

• Newspaper article (a political essay, a scientific report)

• Radio/TV feature (a political discussion on the radio, a documentary on animal life on the TV)

• Drama

– Film

– Play

– Opera

– Musical

• Singing

– Individual Song

– Chant (a psalm, a slogan during a demonstration)

– Chorus

• Instrumental music

• Poetry (a ballad, an oral epic)

• Literature (a short novel, a tragedy)

• Secondary document

• Personal notes

• Stimuli (a picture book elicitation, a story retelling, a matching game)
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Note

If there are several Subgenres, you can enter all of them into the Subgenre field. Separate them
with a comma.

Task

The name of the experimental or stimuli-based task that was carried out (if any). Choose a value from the
pull-down menu (e.g. info-kiosk, wizard-of-oz, travel-planning, room reservation, or frog story), or type in
an alternative value.

Modalities

The modalities under investigation. Choose a value from the pull-down menu (e.g., speech, writing, gestures,
pointing-gestures, signs, eye-gaze, facial-expressions, emotional-state, haptic), or type in an alternative
value.

Subject

The subject(s) or topic(s) of the session. There are no constraints on this field.

Communication Context

Information about the communication context, i.e., levels of participant interaction, the degree of planning
through the speaker(s), the involvement of the researcher(s), the social context, the event structure, and the
channel. All six are 'closed vocabularies', i.e., a value from the pull-down menu must be chosen – other
values will not be accepted. Enter the following information:

• Interactivity

The level of participant interaction, i.e.:

value comments

interactive an interaction between at least two participants. It
may or may not include an investigator, e.g.:

– conversation

– many narratives

– matching game

non-interactive a monologue, produced without expecting extended
verbal responses from the hearer(s), e.g.:

– many oratory texts and songs

– some narratives

semi-interactive primarily a monologue, but punctuated by repeated
interjections from the hearer(s), e.g.:

– a child interrupting a narrative

– hearer(s) repeatedly prompting a narrator

• Planning Type

The degree of planning through the consultant, i.e.:
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value comments

spontaneous an unprompted speech whose topic is not
determined by the investigator or an observer, e.g.:

– conversation

– chatting

– joke-telling

– singing while harvesting

semi-spontaneous a prompted speech whose topic is determined in
some way by an investigator or a community
member, but whose participants speak freely within
this context, e.g.:

– interview

– queries (e.g., ‘Tell me about the history of your
village.’ ‘Show me how to make tortillas.’)

– retellings (e.g., the speaker is asked to re-tell a
story from a picture book, or to describe a task in
his/her own words)

– promptings (e.g., children answering a teacher’s
questions)

planned the structure and content of the speech is planned in
advance by the consultant/performer, e.g.:

– political or ritual speech

– poem recitation

Note

This entry does not (necessarily) refer
to an elicitation session, where a
consultant is given a framework but
does not plan his/her answer.

• Involvement

The involvement of the researcher, i.e.:

value comments

elicited the investigator asks the speaker(s) to
produce isolated phonemes, words, utterances or
grammatical structures, e.g.:

– production of sounds in different phonological
environments

– responses to (morphological, lexical, etc.)
questionnaires
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value comments

non-elicited the investigator does not interfere verbally with the
speech event (other than with his presence)

no-observer no outside observer is present (only a tape recorder)

• Social Context

The social context of the event, i.e.:

value comments

family

private

public

controlled environment

• Event Structure

The event structure, i.e.:

value comments

monologue

dialogue

conversation

not natural format

• Channel

The channel of communication, i.e.:

value comments

face to face

experimental setting

broadcasting

telephone

human-machine dialogue

2.3.2. Descriptions

A description of the content of the session. For example:
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Figure 2.11. Description of Content

See Section A.1 for instructions on how to fill in a Descriptions schema. Remember: The field Language
refers to the language in which the description is written - not to the language under investigation.

2.3.3. Languages

Information about the language(s) used in the session, e.g.:
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Figure 2.12. Language used in the session

1. Language screen: information about the language (see Section 2.3.3.1).

2. Description of the how the language(s) are used in the session (see Section 2.3.3.2).

2.3.3.1. Language

Each language that is used in the session has to be listed on the Language screen. To add a language (see
also Section 1.3), do the following:
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Figure 2.13. Add a language

1. The list of languages.

2. Click on Add to add another language to edit or remove a language, click on the language to highlight
it, then click on Edit or Remove.

The Add and Edit buttons give you access to the Language screen that contains the following kind of
information:
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Figure 2.14. Add and edit a language

• Name

The name of the language. This name is standardized. Choose it from the pull-down menu, or type it in.
(Please use capital letters.)

• ID

The identifier of the language (based on the Ethnologue identifiers, see http://www.ethnologue.com/
web.asp). The IMDI Editor automatically enters the correct identifier once you have filled in the Name
field above.

• Mother Tongue

Please ignore this field. It has been disabled for Content . Language, and is only available for Actor .
Language (see Section 2.4.1.5).

• Primary Language

Please ignore this field. It has been disabled for Content . Language, and is only available for Actor .
Language (see Section 2.4.1.5).

• Dominant Language

Specifies whether or not this language is the language that is used most frequently in the session. From
the pull-down menu, select either true (if it is the dominant language) or false (if it is not).

• Source Language

http://www.ethnologue.com/web.asp
http://www.ethnologue.com/web.asp
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In a second language acquisition context, this field specifies whether or not this language is the source
language. From the pull-down menu, select either true (if it is the source language) or false (if it is not).

• Target Language

In a second language acquisition context, this field specifies whether or not this language is the target
language. From the pull-down menu, select either true (if it is the target language) or false (if it is not).

• Descriptions

A description that gives background information about the language in general. Note that the description
is not about the role of the language in that particular session (reserve this information for the Languages
Descriptions sub-screen, see Section 2.3.3.2). See Section A.1 for instructions on how to fill in a
Descriptions schema. Remember: The field Language refers to the language in which the description is
written - not to the language under investigation.

• Resource References

The IMDI Editor automatically assigns a unique resource identifier to each media file and written resource
(see Section 2.5). The sub-screen Resource References lists all available resource identifiers: it displays
the identifier together with the type of resource (e.g., 'N10155 (Media File)' in the screenshot above), and
it displays an empty box to the left.

This sub-screen allows now you to link the language to a specific resource. E.g., a language may only
be used in resource 'N10155 (Media File)', but not in resource 'N10198 (Media File)'. In this case, the
language should only be linked to 'N10155 (Media File)'. To link a resource, click into the empty box to
its left. A checkmark will appear there.

2.3.3.2. Languages Descriptions

Enter a description of the role of each language as it is used in the session (e.g., language of elicitation, main
language, code-switching, etc.). Note that the description should not contain background information about
the language in general (reserve this for the Language sub-screen, see Section 2.3.3.1). See Section A.1 for
instructions on how to fill in a Descriptions schema. Remember: The field Language refers to the language
in which the description is written - not to the language under investigation.

2.3.4. Keys

This sub-screen contains keywords that are relevant to the content of the session. For example:
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Figure 2.15. Keywords relevant to the Content
Keywords that are relevant to the content, e.g.:

1. The linguistic interest in the session.The topic.

2. The topic.

See Section A.2 for instructions on how to fill in a Keys schema.

2.4. Actors
This screen contains information about the actors involved in the session. All the information that is entered
into the Actors screen will be displayed in the IMDI Browser in the following way (see the IMDI Browser
manual for details):



The IMDI Session Editor

80

Figure 2.16. Actors displayed in the IMDI browser

1. Information about each Actor is displayed under the node Actors (or Participants in the older version).

2. List of actors (see Section 2.4.1).

3. Actors Description (see Section 2.4.2).

2.4.1. Actor

Each actor involved in the session has to be listed on the Actors screen. If an actor occurs in two different
Roles (e.g., once as collector and once as annotator) (s)he has to be listed twice. To add an actor (see also
Section 1.3), do the following:
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Figure 2.17. Add an actor

1. The list of actors.

2. Click on Add to add another actor. To edit or remove an actor, click on the actor to highlight it, then
click on Edit or Remove.

The Add and Edit buttons give you access to the Actor screen that contains the following kind of information:
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Figure 2.18. Actor screens

1. Actor Information (see Section 2.4.1.1).

2. Contact Information (see Section 2.4.1.2).

3. Resource Reference (see Section 2.4.1.3).

4. Description (see Section 2.4.1.4).

5. Languages (see Section 2.4.1.5).

6. Keys (see Section 2.4.1.6).

2.4.1.1. Actor Information

Information about the individual actor. For example:
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Figure 2.19. Actor information

Role

The function of the participant in the session. Choose a value from the pull-down menu, or type in an
alternative value. For example:

value comments

Annotator

Author

Collector

Consultant

Computer

Depositor

Editor

Filmer

Illustrator
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value comments

Interviewer

Photographer

Publisher

Recorder

Referent

Researcher

Speaker/Signer

Translator

Name

The name of the actor, i.e., the name that other actors in the session use to identify him/her. It is usually not
the same as his/her full name. (See also the field Anonymized below.)

Full Name

The full name of the actor. (See also the field Anonymized below.)

Code

Short unique code to identify the actor. It usually corresponds to the code that is used in transcriptions and
annotations to identify parts that were uttered by him/her. (See also the field Anonymized below.)

Social Family Role

The social or family role of the actor, i.e., his/her relationship to other actors participating in the session.
Choose a value from the pull-down menu, or type in an alternative value. For example:

value comments

Father

Mother

Sibling

Boss

Partner

Student

Teacher

Shaman/Priest

Mayor

Doctor

Ethnic Group

The ethnic group of the actor.

Age

The age of the actor. Please enter the age in the following format: YY or YY;MM or YY;MM.DD.
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Note

If the exact age is not known, it is nevertheless useful to enter an approximate age. This will
allow you later to conduct searches on all actors who are in the age range between, e.g., 20
and 30 years of age.

Sex

The sex of the actor. It has to be chosen from the pull-down menu.

Education

Type in the education or literacy level of the actor. For example: primary school, secondary school, literate,
illiterate, etc. There are no constraints on this field.

Anonymized

Specifies whether or not the actor’s name was made anonymous.

Choose true if you have entered a code in the field Full Name.

Choose false if you have entered the full name in the field Full name.

Note

If you have chosen the option true, you can create a conversion file that maps the code onto
the full name. Make use of the menu item Options > Anonyms … (see Section 1.2.3.2). If
you have created such a file, the actor information is entered, saved and displayed as follows:

1. Enter the same full name as in the conversion file into the field Name or Full Name.

Figure 2.20. Participants full name
Enter the full name
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Note

The code entered into the field Full Name should not be the same as the code
entered into the field Code.

2. The name that you have entered into the field Name or Full Name is saved in the IMDI
file as follows:

@Institute: Project: User: Code@

Figure 2.21. Saved code
The code is saved in the IMDI file

3. The IMDI Editor accesses the mappings that you have defined in the Anonyms overview
dialog window (see Section 1.2.3.2), and displays the full name.

Figure 2.22. Anonyms mapping
The IMDI Editor accesses the mappings between full names and codes, and displays the
full names

All people who have access to the file that specifies these mappings will be able to see the
full name, all others will see the code.
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Note

Previous versions of the IMDI Editor supported a different method for rendering full names
anonymous. If you have old IMDI files and if you have doubts about how the full names are
displayed, please contact your corpus manager.

2.4.1.2. Contact Information

Contact information about the actor (the Name, the Address, the E-mail address and the Organisation he/she
belongs to).

2.4.1.3. Resource References

The IMDI Editor automatically assigns a unique resource identifier to each media file and written resource
(see Section 2.5). The sub-screen Resource References lists all available resource identifiers: it displays the
identifier together with the type of resource (e.g., 'N0x80564c0.0x80806a8 (Media File)' in the screenshot
below), and it displays an empty box to the left.

Figure 2.23. Resource References

The sub-screen Resource References now allows you to link the actor to a specific resource. E.g., an
actor may only appear in the specified Role in resource 'N0x80564c0.0x80806a8 (Media File)', but
not in resource 'N0x80564c0.0x808cc78 (Media File)'. In this case, the actor should only be linked to
'N0x80564c0.0x80806a8 (Media File)'. To link a resource, click into the empty box to its left. A checkmark
will appear there.

2.4.1.4. Descriptions

A general description of the individual actor (independent of his/her Role in the session). For example:
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Figure 2.24. Actor descriptions
Description of the actor

See Section A.1 for instructions on how to fill in a Descriptions schema. Remember: The field Language
refers to the language in which the description is written - not to the language under investigation.

2.4.1.5. Languages

Information about all the languages that the actor is familiar with (independent of whether or not the actor
uses them in the session).
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Figure 2.25. Language screens

1. Language screens: general information about each language

2. Description of the actor’s use of and familiarity with the languages

Languages

Each language that is spoken by the actor has to be listed on the Language screen. To add a language (see
also Section 1.3), do the following:
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Figure 2.26. Languages

1. The list of languages

2. Click on Add to add another language. To edit or to remove languages, click on the language to highlight
it, then click on Edit or Remove

The Add and Edit buttons give you access to the Language screen that contains the following kind of
information:
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Figure 2.27. Languages spoken by the actor

• Name

The name of the language. This name is standardized. Choose it from the pull-down menu, or type it in.
(Please use capital letters.)

• ID

The identifier of the language (based on the Ethnologue identifiers, see http://www.ethnologue.com/
web.asp). The IMDI Editor automatically enters the correct identifier once you have filled in the Name
field above.

• Mother Tongue

Specifies whether or not this language is the mother tongue of the actor. From the pull-down menu, select
either true (if it is the mother tongue) or false (if it is not).

• Primary Language

Specifies whether or not this language is the language that the speaker is most fluent in. From the pull-
down menu, select either true (if it is the most fluent language) or false (if it is not).

http://www.ethnologue.com/web.asp
http://www.ethnologue.com/web.asp
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• Dominant Language

Please ignore this field. It has been disabled for Actor . Language, and is only available for Content .
Language (see Section 2.3.3.1).

• Source Language

Please ignore this field. It has been disabled for Actor . Language, and is only available for Content .
Language (see Section 2.3.3.1).

• Target Language

Please ignore this field. It has been disabled for Actor . Language, and is only available for Content .
Language (see Section 2.3.3.1).

• Descriptions

A description that gives background information about the language in general. Note that the description
is independent of the actor’s familiarity with it (reserve such information for the Languages Descriptions
sub-screen below). See Section A.1 for instructions on how to fill in a Descriptions schema. Remember:
The field Language refers to the language in which the description is written - not to the language under
investigation.

• Resource References

Please ignore this sub-screen. It has been disabled for Actor . Language, and is only available for Content
. Language (see Section 2.3.3.1).

Languages Descriptions

A description of the set of languages that the participant is familiar with. Note that the description does not
contain background information about the language in general (reserve this for the Language . Descriptions
schema above). See Section A.1 for instructions on how to fill in a Descriptions schema. Remember:
The field Language refers to the language in which the description is written - not to the language under
investigation.

2.4.1.6. Keys

This sub-screen contains keywords that are relevant to the individual actor (independent of his/her Role in
the session).
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Figure 2.28. Actor keys
Example of keys that are relevant to the actor.

See Section A.2 for instructions on how to fill in a Keys schema.

2.4.2. Actors Descriptions
A description of the interactions and interrelations among different actors of the session. Note that this
description concerns the set of actors as a whole – information about specific actors should be described by
means of Actor . Descriptions (see Section 2.4.1.4).

Figure 2.29. Actors descriptions

See Section A.1 for instructions on how to fill in a Descriptions schema. Remember: The field Language
refers to the language in which the description is written - not to the language under investigation.

2.5. Resources
This screen contains information about the resources belonging to the session. All the information that is
entered into the Resources screen will be displayed in the IMDI Browser in the following way (see the IMDI
Browser manual for details):
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Figure 2.30. Resources displayed in the IMDI browser
Information on the screen Resources is displayed under the resource nodes

1. Anonymous (see Section 2.5.1).

2. Media Files (see Section 2.5.2).

3. Written Resources (see Section 2.5.3).

4. Sources (see Section 2.5.4).

The IMDI Editor automatically assigns a unique resource identifier to each media file and written resource.
The resource identifiers are then used on the sub-screen Resource References to link a source (see
Section 2.5.4.3), an actor (see Section 2.4.1.3) or a language (see Section 2.3.3.1) to a specific resource.
E.g., it may be the case that an actor only plays a role in one of the resources, but not in the others – in this
case, you can use the resource identifiers to link the actor to this one resource, but not to the others.

Click on the button Links at the top of the Content panel to view all links, e.g.:
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Figure 2.31. Resource links

1. Click here to view all links
2. Sources, actors and languages, and the resources they are linked to
3. Resources: file name, resource identifier and time position (if applicable)

Within this Links window, you can click on any source, actor, language or resource to jump to the
corresponding screen.

Note

If you remove a resource, the specified links are automatically removed as well.

2.5.1. Anonymous
If you have made the names of actors anonymous (on the screen Actors, see Section 2.4.1.1) and if you
have created a file that maps these codes onto full names (by using the menu item Options > Anonyms
…, see Section 1.2.3.2), you can use the screen Anonymous to specify access rights to this mapping file.
As illustrated in Section 1.2.3.2, the mapping file is stored under the name user-name.ano in the folder
<user-directory> \ IMDI-TOOLS \ Anonyms on your desktop computer – i.e., it is only available
to you. However, you might want to store a copy of it in the corpus itself (e.g., to protect it against data loss,
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in case of a system error). In this case, store the file in your corpus (or ask your corpus manager to do it for
you), specify the name and directory of the file, and the access rights to it. See Section A.3 for instructions
on how to fill in an Access schema.

2.5.2. Media Files

Each digitized media file (e.g. audio, video or image file) associated with the session has to be listed on the
Media Files screen. To add a media file (see also Section 1.3), do the following:

Figure 2.32. Media files

1. the list of media files

2. Click on Add to add another file. To edit or remove a file, click on the file to highlight it, then click
on Edit or Remove

The Add and Edit buttons give you access to the Media File screen that contains the following kind of
information:
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Figure 2.33. Media file screen

1. Media File screen (see Section 2.5.2.1)
2. Time position (see Section 2.5.2.2)
3. Access (see Section 2.5.2.3)
4. Keys (see Section 2.5.2.4)
5. Description (see Section 2.5.2.5)

2.5.2.1. Media File

This screen contains general information about the media file, i.e.:

• Resource ID

The IMDI Editor automatically assigns a unique resource identifier to each media file. This assignment
is automatic, and cannot be influenced by the user (see Section 2.5).

• Resource Link

The link to the corresponding media file, i.e., its name and location.

Note

Note for researchers working at the MPI for Psycholinguistics, Nijmegen: Please specify
only the name of the file – do not make use of the open folder icon to the right of the Link
field. The name of the media file should be the same as the name of the IMDI file (see
Section 1.2.1.12), and as the name entered in the field Session Name (see Section 2.1.1).
Furthermore, the file name has to be Unix compatible: do not use file names longer than 14
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characters, do not use non-letter or non-number characters (except for the underscore: _),
and do not use blank spaces.

• Size

The (approximate) size of the media file in bytes. Note that this field is not standardized: it is meant to be
read by humans (to give them an indication of the size before they, e.g., download it), not to be processed
through the computer.

• Type

The type of the media file. Choose a value from the pull-down menu, or type in an alternative value.

value comments

audio

video

image

document

drawing

text

• Format

The format of the media file. Choose a value from the pull-down menu, or type in an alternative value.

value comments

video/mpeg1

video/mpeg2

video/mpeg4

video/quicktime

audio/wav

audio/aiff

image/jpeg

text/pdf

text/html

• Quality

The quality of the recording. Choose an option from the pull-down menu (1 stands for low and 5 for
high quality).

• Recording Conditions

The technical conditions under which the media file was recorded, e.g., the equipment used in the
recording (e.g., microphone type, amplifier type, mono/stereo recording, etc.). There are no constraints
on this field.

2.5.2.2. Time Position

The start/end position of the session on the media file. Please enter the start/end position in the following
format: hh:mm:ss:f (i.e., hours:minutes:seconds:frames).
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2.5.2.3. Access

Information about the access rights to the media file. See Section A.3 for instructions on how to fill in an
Access schema.

2.5.2.4. Keys

Keywords that are relevant to the media file. See Section A.2 for instructions on how to fill in a Keys schema.

2.5.2.5. Descriptions

A description of the media file. See Section A.1 for instructions on how to fill in a Descriptions schema.
Remember: The field Language refers to the language in which the description is written - not to the language
under investigation.

2.5.3. Written Resources

Each written resource associated with the session has to be listed on the Written Resources screen. To add
a written resource (see also Section 1.3), do the following:

Figure 2.34. Add written resource

1. the list of written resources

2. Click on Add to add another written resource. To edit or remove a written resource, click on the written
resource to highlight it, then click on Edit or Remove

The Add and Edit buttons give you access to the Written Resource screen that contains the following kind
of information:
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Figure 2.35. Add and edit a written resource

1. Written Resource screen (see Section 2.5.3.1)

2. Information (see Section 2.5.3.2)

3. Validation (see Section 2.5.3.3)

4. Access (see Section 2.5.3.4)

5. Keys (see Section 2.5.3.5)

6. Descriptions (see Section 2.5.3.6)

2.5.3.1. Written Resource

This screen contains general information about the written resource, i.e.:c

• Resource ID

The IMDI Editor automatically assigns a unique resource identifier to each written resource. This
assignment is automatic, and cannot be influenced by the user (see Section 2.5).

• Date

The date when the written resource was created. Please enter the date in the following format: YYYY-
MM-DD, e.g. 2000-12-30.

• Resource Link

The link to the file containing the written resource, i.e., its name and location.



The IMDI Session Editor

101

Note

Note for researchers working at the MPI for Psycholinguistics, Nijmegen: Please specify
only the name of the file – do not make use of the open folder icon to the right of the Link
field. The name of the written resource should be the same as the name of the IMDI file (see
Section 1.2.1.12), and as the name entered in the field Session Name (see Section 2.1.1).
Furthermore, the file name has to be Unix compatible: do not use file names longer than 14
characters, do not use non-letter or non-number characters (except for the underscore: _),
and do not use blank spaces.

• Media Resource

The link to the media file from which the written resource originated (if applicable).

• Anonymous

Specify whether or not you have made actors’ names anonymous in the written resource.

Choose true if you have used a code.

Choose false if you have used the real name.

2.5.3.2. Information

• Type and Subtype

The type and subtype of the written resource, whereby Subtype is dependent on Type. I.e., the value that
you enter under Type will determine the values that are available under Subtype. Both Type and Subtype
are 'open vocabularies', i.e., you do not have to select a value from the pull-down menu, but can enter an

alternative value instead. The following values have been suggested3:

– Type

—Subtype (Example)

– Primary Text (any material that is the object of study)

—Documentary

—Fiction

– Annotation (an annotation (e.g., transcription or grammatical analysis) of the material under study)

—gesture

—orthography

—phonetic

—phonology

—morphology

—morphosyntax

—syntax

—semantics
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—pragmatics

—typology

– Lexical analysis (a lexical analysis of the material under study)

—dictionary

—terminology

—wordlist

—lexicon

– Ethnography (an ethnographic analysis of the material under study)

– Study (the written resource is used for a specific subfield of linguistic science)

Note

If there are several Subtypes, you can enter all of them into the Subtype field. Separate them
with a comma (e.g., "orthography, morphology").

• Format

The file format of the file that contains the written resource. Choose a value from the pull-down menu,
or type in an alternative value.

value comments

CHAT

Shoebox

RDBMS

TRS

EAF

AIF

BAS

text/plain

text/pdf

text/html

• Size

The (approximate) size of the written resource in words.

• Derivation

The relation of the written resource to other documents. It is a 'closed vocabulary', i.e., the value has to
be chosen from the pull-down menu, i.e.:

value comments

Analysis

Translation
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value comments

Commentary

Criticism

Annotation

• Content Encoding

The name of the encoding scheme used for creating the written resource (if applicable). For example:
Eurotype (i.e., following the Eurotype guidelines)

• Character Encoding

The name of the character encoding used for creating the written resource, e.g., UTF-8.

• Language ID

The identifier of the language that is used in the written resource, e.g. 'English' for an English translation.
It has to be entered in a standard format. Please enter either the ISO identifier (i.e., enter 'ISO639:eng' for
English), or the Ethnologue identifier (i.e., enter 'RFC1766:x-sil-eng' for English) – please look up the ISO
identifiers under http://lcweb.loc.gov/standards/iso639-2/langhome.html, and the Ethnologue identifiers
under http://www.ethnologue.com/web.asp.

2.5.3.3. Validation

Gives information about the validation state of the written resource.

• Type

The type of validation. It is a 'closed vocabulary', i.e., you have to choose a value from the pull-down
menu, i.e.:

value comments

formal

content

• Methodology

The methodology of validation. It is a 'closed vocabulary', i.e., you have to choose a value from the
pull-down menu, i.e.:

value comments

hand

automatic

semi-automatic

• Level

Gives an estimation of how much of the resource was validated (enter a value between 0 and 100%).

• Description

A description of the validation. See Section A.1 for instructions on how to fill in a Descriptions schema.
Remember: The field Language refers to the language in which the description is written - not to the
language under investigation.

http://lcweb.loc.gov/standards/iso639-2/langhome.html
http://www.ethnologue.com/web.asp
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2.5.3.4. Access

Information about the access rights to the file containing the written resource. See Section A.3 for
instructions on how to fill in an Access schema.

2.5.3.5. Keys

Keywords that are relevant to the written resource. See Section A.2 for instructions on how to fill in a Keys
schema.

2.5.3.6. Descriptions

A description of the written resource. See Section A.1 for instructions on how to fill in a Descriptions
schema. Remember: The field Language refers to the language in which the description is written - not to
the language under investigation.

2.5.4. Sources

Each source (e.g., video or audio tapes, or books) associated with the session has to be listed on the Sources
screen. To add a source (see also Section 1.3), do the following:

Figure 2.36. Add a source

1. The list of sources

2. Click on Add to add another source. To edit or remove a source, click on the source to highlight it, then
click on Edit or Remove

The Add and Edit buttons give you access to the Source screen that contains the following kind of
information:
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Figure 2.37. Add and edit a source

1. Source screen (see Section 2.5.4.1)
2. Position (see Section 2.5.4.2)
3. Resource Reference (see Section 2.5.4.3)
4. Access (see Section 2.5.4.4)
5. Keys (see Section 2.5.4.5)
6. Descriptions (see Section 2.5.4.6)

2.5.4.1. Source

This screen contains general information about the source, i.e.:

• Source ID

A short code to identify the source.

Note

Note for researchers working at the MPI for Psycholinguistics, Nijmegen: Please consult
the tape labeling conventions.

• Format

The physical storage format of the source. Choose a value from the pull-down menu, or type in an
alternative value.
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value comments

CC Compact Cassette (i.e., normal audio cassette)

CD Compact Disc

CDROM Compact Disc - Read-Only Memory

DAT Digital Audio Tape

MD Mini Disc

Reel Reel-to-reel tape

DVD Digital Video Disc

DVDROM Digital Video Disc - Read-Only Memory

Hi8 Hi8 Video Tape

VHS VHS Video Tape

DV Digital Video

U-matic U-matic Tape

Book A publication on paper

Microfiche A film card

• Quality

The quality of the tape. Choose an option from the pull-down menu (1 stands for low and 5 for high
quality).

2.5.4.2. Position

The start/end position of the session in the corresponding source. Please enter this position in the following
formats:

• In the case of digital audio tapes use the field Time Position: enter hh:mm:ss (i.e., hours:minutes:seconds).

• In the case of digital video tapes use the field Time Position: enter hh:mm:ss:f (i.e.,
hours:minutes:seconds:frames).

• In the case of non-digital tapes and books, use the field Counter Position: enter a sequence of digits to
represent the counter position (of a tape) or the page numbers (of a book).

Note

Note for researchers working at the MPI for Psycholinguistics, Nijmegen: If you have asked
the digitization team to digitize your tape, the team will create a digital master file (DMF) from
it. You then need to go through this DMF (using either Windows Media Player or ELAN) to
identify the relevant session: enter the start and end position of this session (as it appears on
this DMF) under Position. The digitization team will then segment the DMF further according
to these specifications, and create the appropriate media file.

2.5.4.3. Resource References

The IMDI Editor automatically assigns a unique resource identifier to each media file and written resource
(see Section 2.5). The sub-screen Resource References lists all available resource identifiers: it displays the
identifier together with the type of resource (e.g., 'N10155 (Media File)' in the screenshot below), and it
displays an empty box to the left.
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Figure 2.38. Resource reference

The sub-screen Resource References now allows you to link the source to a specific media file or written
resource. E.g., a source may only be connected to the media files (e.g., 'N10155 (Media File)' and 'N10198
(Media File)'), but not to a written resource. To link a resource, click into the empty box to its left. A
checkmark will appear there.

2.5.4.4. Access

Information about the access rights to the source. See Section A.3 for instructions on how to fill in an Access
schema.

2.5.4.5. Keys

Keywords that are relevant to the source. See Section A.2 for instructions on how to fill in a Keys schema.

2.5.4.6. Descriptions

A description of the source. See Section A.1 for instructions on how to fill in a Descriptions schema.
Remember: The field Language refers to the language in which the description is written - not to the language
under investigation.

2.6. References
This schema contains cross-references to other sessions, fieldnotes, or publications that are relevant to the
content of the session. All the information that is entered into the References screen will be displayed in the
IMDI Browser in the following way (see the IMDI Browser manual for details):
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Figure 2.39. References displayed in the IMDI browser

2.7. Changes to the metadata categories
(IMDI 3.0 standard)

The most important change implemented in the IMDI Editor version 3.0 concerns the supported metadata
categories: the Editor now supports the IMDI 3.0 standard, and all IMDI files created with this version of
the Editor will automatically conform to this new standard. IMDI files created with an older version of the
Editor need to be converted to the new standard.

This section first summarizes the implemented changes (see Section 2.7.1), and then describes the conversion
of old IMDI files (see Section 2.7.2) and old repositories (see Section 2.7.3) to the 3.0 standard.

2.7.1. Changes to the metadata categories

The following changes in metadata categories were implemented in the IMDI 3.0 standard:

IMDI 2.0 (and earlier) Standard IMDI 3.0 Standard

Collector this screen is now subsumed under Actor, with
collector being one possible value for the field Role
(see Section 2.4.1.1).

Content . Genre . Interactional

Content . Genre . Discursive

Content . Genre . Performance

the three subtypes of genre are replaced by one Genre
and one Subgenre, whereby the possible values of
Subgenre are dependent on the value of Genre (see
Section 2.3.1).

Language an additional panel allows you to specify resource
references (see Section 2.3.3.1).
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IMDI 2.0 (and earlier) Standard IMDI 3.0 Standard

Participant this screen is replaced by Actor;

Actor now includes Contact information;

an additional panel allows you to specify resource
references (see Section 2.4.1.3)

AnotationUnit this screen is replaced by Written Resource (see
Section 2.5.3)

Resources a Keys schema is added;

Media File and Written Resource are assigned
Resource Ids;

an additional panel under Source allows you to
specify resource references

(see Section 2.5)

Lexicon Resource this screen is added to create lexicon resource
bundles (see Chapter 3).

2.7.2. Conversion of old IMDI files to the 3.0 standard

The IMDI Editor version 3.0 supports the IMDI 3.0 standard. Files that were created with an older version
of the Editor can still be opened, but they need to be converted to the new standard. The conversion process
is as follows:

1. Open the old file in the IMDI Editor 3.0 (see Section 1.2.1.6 for how to open a file). The following
warning will appear:

Figure 2.40. XSL transformer

2. Click on OK in both windows to convert the file. (Otherwise click on Cancel to not convert it.) The file
will be converted to the 3.0 standard, using the default profile for that type of file (see Section 1.2.3.1
for details on profiles). A backup copy of the file in its old standard will be saved with the extension
*.old.imdi.

A window appears, informing you about this process, e.g.:
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Figure 2.41. Conversion warning
The file in the old standard has been saved with the extension *.old.imdi

Furthermore, the converter informs you about any errors that took place during the conversion process.
Click on Next to read this information.

The following two types of errors can occur:

a. Errors concerning the Genre element: In earlier versions, Genre consisted of three separate subtypes.
These were removed and were mapped onto one Genre and one Subgenre instead (see Section 2.7.1).
While some of these mappings are known to the converter, others are not. If the mapping is not
known, the converter will generate an error message, informing you that the old Genre has been
mapped onto the Keys schema of the Content screen instead (see Section 2.3.4), e.g.:

Figure 2.42. Conversion warning: Genre to Keys
i. Generated warning

ii. The old Genre has been mapped onto the Keys schema of the Content screen

Please remove this keyword manually, and fill in the Genre and Subgenre fields by hand.
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b. Errors concerning the usage of wrong values, e.g., the usage of a wrong format (such as a wrong
format for a date or an age) or the usage of a value that is not specified in a closed controlled
vocabulary (see Section 1.2.3.3 for controlled vocabularies). In all these cases, you will receive the
following message, informing you that such errors were detected:

Figure 2.43. Conversion warning: wrong values

In the IMDI file itself, such errors are highlighted in orange color, and a description of the error is
added to the tool-tip (which is activated by pointing with the mouse to the category label). You can
navigate to these errors by using the two arrow buttons at the top of the Content panel, e.g.:
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Figure 2.44. Navigate to errors
i. Use these buttons to move to the previous / next error

ii. Point here to activate the tool-tip

iii. A description of the error is added to the tool-tip

iv. The error is highlighted in orange color

Please fill in the correct values by hand.

Note

Unless you manually change the items that do not conform to the IMDI 3.0 standard,
the error messages will continue to appear (in the case of the Genre errors), and the
offending items will continue to be highlighted in orange (in the case of the value
errors).

Note

If the converter was able to map the old Genre onto the new Genre, it will inform you of
this fact: it will add a description (under Content . Description) and it will additionally
display the old Genre as keywords (under Content . Keys), e.g.:
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Figure 2.45. Description and resulting keywords of genre mapping
i. A description informing you of the successful conversion

ii. The old Genre is additionally displayed in the form keywords

2.7.3. Conversion of old repositories to the 3.0
standard

When you start the IMDI Editor version 3.0 for the first time, it will automatically convert all old repositories
to the new IMDI 3.0 standard (see Section 1.4 for details on repositories). The converted repository is not
added to the node Local Repository, but to the node Local (Old IMDI Version). The old repositories are not
deleted – if you need to revert back to an older version of the IMDI Editor, the unconverted repositories
will be used again.
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Figure 2.46. The old repository is converted
The old repository is automatically converted and added to the node Local (Old IMDI Version)
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Chapter 3. The IMDI Profile Editor
If you have special requirements with regards to metadata files, like a fixed set of user-defined keys, it might
be a good idea to set up a special profile for this cause. Such a profile is a kind of a template for the creation
of new IMDI files. You can enter extra constraints for the fixed fields and set up predefined key fields.

3.1. Creating a new profile
From the File pulldown menu, select New Profile…

First select an existing profile as a starting point for your own modified profile. Generally this will be the
default profile, the Standard (Session) Resource Bundle. Now click on OK to confirm your choice.

Figure 3.1. Select Base Profile

After saving (as usual, File > Save as…) you can choose the newly created profile from the list when
creating a new file using File > New….

Note

make sure the profile ends in .Profile.xml, otherwise it will not show up in the list of
available profiles.

Note

In version 3.2 of the IMDI editor, the Multiplicity fields are not yet working. For the time
being, please ignore them.
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For an example of a profile, where the Project ID is restricted to a number and the predefined value 111 is
filled in by default, see the screenshots below.

Figure 3.2. Creating and using a profile

1. Creating a profile
2. The only content that will be accepted in this field is an integer; its content will be automatically appear
3. These fields are not yet functional
4. Enter a custom help text, this will appear in the help baloon for this field.
5. Using a profile
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Chapter 4. The IMDI Lexicon Editor
The IMDI Lexicon Editor creates IMDI Lexicon files (*.imdi) that describe lexicon resources. Its structure
is almost identical to the IMDI Session Editor, i.e., it displays the screens Session (see Section 2.1), Project
(see Section 2.2), Content (see Section 2.3), Actors (see Section 2.4), and References (see Section 2.6).
The only difference concerns the screen Resources: the IMDI Lexicon Editor does not display Anonymous,
Media Files, Written Resources and Sources – instead it displays Lexicon Resource. This section of the
manual describes only the screen Lexicon Resource. For the other screens, please consult Chapter 2.

4.1. Lexicon Resource
The lexicon resource associated with the session is listed under Lexicon Resource, which allows you to give
general information about the resource, about its lexical entries, about the metalanguage used, and about
access rights and restrictions to the resource. You can furthermore give a prose description and add keywords.

Figure 4.1. Lexicon Resource

1. The lexicon resource

2. Metadata information about the lexicon resource



The IMDI Lexicon Editor

118

Note

This part of the IMDI Editor is still under development, and the controlled vocabularies
for the metadata categories have not yet been specified. Please consult the web page http://
www.mpi.nl/IMDI/ for further information.

http://www.mpi.nl/IMDI/
http://www.mpi.nl/IMDI/
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Chapter 5. The IMDI Corpus Editor
This part of the manual guides you through using the IMDI Corpus Editor to create a corpus hierarchy.
All sessions or resource bundles (see Chapter 2) and lexicon resource bundles (see Chapter 3) belong to a
corpus, e.g., to the corpus of the language XY, which, in turn, is subdivided according to various criteria
(e.g., it may be subdivided on the basis of genre, or on the basis of the age of the participants, etc.).

Note

In many cases, the corpus manager takes care of structuring your corpus, i.e., you will not
need the IMDI Corpus Editor. You only need the Corpus Editor in case you manage your own
corpus.

Note

Note for researcher working at the MPI for Psycholinguistics, Nijmegen: If you
plan on using the IMDI Corpus Editor, please contact corpus.manager@mpi.nl
[mailto:corpus.manager@mpi.nl] first.

The IMDI Corpus Editor creates an IMDI Corpus file (*.imdi).

The following steps are necessary to create, structure and manage a corpus:

1. Specify the directory information of all info, media, written resource and lexicon files that belong to a
session, and of all IMDI files that belong to a corpus (see Section 5.1).

2. Select the sessions that belong to a subcorpus. Select the subcorpora that belong to a corpus (see
Section 5.2).

3. Create a corpus node (see Section 5.3).

These steps are explained in the following three sections.

5.1. Specify the directory information of files
The IMDI Editor creates links to different types of files. These links are entered into fields that are labeled
Link (see also Section 1.5.3):

• In the IMDI Session Editor, Link fields exist for info files (see Section A.1), media files (see Section 2.5.2),
and written resource files (see Section 2.5.3).

• In the IMDI Lexicon Editor, Link fields additionally exist for lexicon files (see Section 4.1).

• In the IMDI Corpus Editor, Link fields exist for IMDI Session, IMDI Lexicon and IMDI Corpus files,
i.e., files created with the IMDI Session, Lexicon or Corpus Editor (see Section 5.2).

In order to link files, you need to provide information about (a) their names and (b) their directory location.

Usually, if your corpus is managed by a corpus manager, you only need to enter the file name. In this case,
type the file name directly into the Link field of the IMDI Session, Lexicon or Corpus Editor. Do not make
use of the browsing option (i.e., the open folder icon to the right of the Link field). Please make sure that no
prefixes are defined in the View > Preferences … > Prefixes menu (see Section 5.1.2).

However, if you manage your own corpus, you need to enter both the file name and the directory location.
You can enter this information either directly into the Link field (see Section 5.1.1) or you can make use
of prefixes (see Section 5.1.2).

mailto:corpus.manager@mpi.nl
mailto:corpus.manager@mpi.nl
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5.1.1. Link fields
You can enter the directory information directly into the Link field. Do the following:

1. Make sure that the browsing option is set correctly. Do the following:

a. In the IMDI Editor, click on Options menu.

b. Click on Preferences ….

c. In the Preferences dialog window, click on Resources.

d. In the Resources dialog window, make sure that there is no checkmark in the box next to Retain only
the filename when browsing.

Note

If there is a checkmark in this box, the directory information will not be saved, e.g.:

Figure 5.1. Retain only the filename when browsing
i. File name and directory information is retained
ii. Only file name is retained

2. Make sure that the preferences are set correctly. Do the following:

a. In the IMDI Editor, click on Options menu.

b. Click on Preferences ….

c. In the Preferences dialog window, click on Prefixes.
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d. In the Prefixes dialog window, make sure that there is a checkmark in the box next to Use these
prefixes only when none were defined in the original IMDI file (see Section 5.1.2).

3. In the IMDI Editor, click on the open folder icon to the right of the Link field. The Open dialog window
appears.

Figure 5.2. Link: open folder
a. Link field

b. Open folder icon

c. Open dialog window

4. In the Open dialog window, navigate to the folder that contains the file.

5. Double-click on the file to insert its name and directory location into the Link field.

5.1.2. Prefixes

You can enter the directory information by means of prefixes. Do the following:

1. In the IMDI Editor, click on Options menu.

2. Click on Preferences ….

3. In the Preferences dialog window, click on Prefixes. The Prefixes dialog window opens.

4. In the Prefixes dialog window, specify when the prefixes should be used. Choose one of the following
two options (by clicking in the box next to this option):

a. Use these prefixes only when none were defined in the original IMDI file.
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I.e., if the directory in formation is already specified in the original IMDI file, the prefixes defined
in the Prefixes dialog window will not be used.

b. Always use the prefixes defined in this panel.

I.e., the prefixes are always used – even if a different directory is specified in the original IMDI file.

5. In the Prefixes dialog window, specify where you have defined the prefixes. Choose one of the following
two options (by clicking in the box next to it):

a. Use Prefixes defined in the IMDI file itself.

Choose this option if the prefixes are defined in the Prefixes dialog window. These prefixes will
then be saved within the IMDI file itself. To define prefixes, enter the directory information for each
type of file, e.g.:

• Global: the directory that is shared by all files, e.g., the path D:\WINNT\Personal\IMDI\
in the illustration below.

• Session Files: the location of your IMDI Session files (relative to Global), e.g., the folder
Metadata_files\ in the illustration below.

• Corpus Files: the location of your IMDI Corpus files (relative to Global).

• Info Files: the location of your info files (relative to Global).

• Media Files: the location of your media files (relative to Global).

• Written Resources: the location of your written resource files (relative to Global).

• Anonymous Info: the location of your file that specifies the mapping of codes onto full names
(relative to Global).

Note

Please add a backslash after each folder.

Note

This option is especially useful whenever files of the same type are stored in the
same directory – because then you only need to specify the directory information
once in the Prefixes dialog window.
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Figure 5.3. Specify the global directory
Directory information of files

b. Use Prefixes defined in an external configuration file.

Choose this option if the prefixes are defined in an external configuration file.

This option is more flexible than option (1) above because the prefixes are not saved in the IMDI
file itself. I.e., if you decide to move files to a different directory at a later stage, you need to change
the prefixes only once in the external configuration file – not in each IMDI file. It is therefore
recommended that you make use of this option whenever you manage a large corpus.

If you choose this option, you are prompted to enter the name and directory of the configuration file.
It should be in the same folder as your IMDI Session files.
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Figure 5.4. Enter the name of the configuration file
i. Enter name and directory of the configuration file

ii. Example of a configuration file

Note

All preferences that have been set in the Options > Preferences … menu are
automatically used for each new IMDI file – unless you change them manually.
Whenever you create a new IMDI file, please make sure that the preferences are set
correctly, so that you do not accidentally insert wrong prefixes.

There is a tool-tip available that reminds you of the defined prefixes. To access it, point with the
mouse into the Link field. A blue box appears informing you about the prefixes.

5.2. Select the sessions and subcorpora that
belong to a corpus

A corpus consists of subcorpora and sessions. For example, the following illustration shows a corpus labeled
'Goemai corpus (preliminary version)', together with its two subcorpora 'Natural data' and 'Elicited data'.
The subcorpus 'Elicited data' contains further subcorpora (labeled 'Matching games' and 'Picture books').
Each subcorpus consists of sessions (labeled 'Session1' to 'Session6') that contain the actual session data (i.e.,
IMDI Session files with metadata information and links to info, media, written resource, and lexicon files).

Goemai corpus (preliminary version):

Natural data

Session1

Session2

Session3

Elicited data
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Matching games

Session4

Session5

Picture books

Session6

To specify such a hierarchical corpus structure, you need to create an IMDI Corpus file for each corpus and
subcorpus. You are asked to provide the following information:

1. Corpus Name:

A short name or abbreviation that uniquely identifies the corpus or subcorpus.

Note

Note for researchers working at the MPI for Psycholinguistics, Nijmegen: The Corpus
Name should be the same as the name of the corresponding IMDI Corpus file. Furthermore,
the file name has to be Unix compatible: do not use file names longer than 14 characters,
do not use non-letter or non-number characters (except for the underscore: _), and do not
use blank spaces.

2. Corpus Title:

The complete title of the corpus or subcorpus. Usually, it is the spelled out version of the abbreviated
Name.

3. Descriptions:

Descriptive information about the corpus or subcorpus. See Section A.1 for instructions on how to fill in
a Descriptions schema. Remember: The field Language refers to the language in which the description
is written - not to the language under investigation.

4. Corpus Links:

Specify links to (a) all IMDI Session files or (b) all IMDI Corpus files that belong to the subcorpus or
corpus.

a. Specify the IMDI Session files that belong to the subcorpus. E.g., in the IMDI Corpus
file Natural.imdi (i.e., 'Natural data'), specify that it contains the IMDI Session files
Session1.imdi, Session2.imdi and Session3.imdi.
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Figure 5.5. Specify the IMDI session files
Specify the links to the IMDI Session files

b. Specify the IMDI Corpus files that belong to the corpus or subcorpus. E.g., in the IMDI Corpus
file Goemai.imdi (i.e., 'Goemai corpus (preliminary version)'), specify that it contains the IMDI
Corpus files Natural.imdi (i.e., 'Natural data') and Elicited.imdi (i.e., 'Elicited data').

Figure 5.6. Specify the IMDI corpus files
Specify the links to the IMDI Corpus files

To specify a link, do the following:
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a. Click on the Add button. The CorpusLink dialog window appears.

Figure 5.7. Add Corpus Link

b. Enter the name of the session or corpus in the field Name.

c. Specify the directory location of the corresponding IMDI Session/Corpus file in the field Corpus
Link.

5.3. Create a corpus node
As the last step, you need to create a corpus node in the IMDI Browser. To create such a node, do the
following:

1. Open the IMDI Browser.

2. At the bottom of the Metadata Descriptions Tree panel, enter the location of the IMDI Corpus file into
the field labeled Root URL. Press ENTER.

The corpus node, together with its subcorpus nodes and sessions, is displayed in the Metadata
Descriptions Tree panel, e.g.:
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Figure 5.8. Metadata Descriptions Tree panel in the IMDI browser
a. Enter the directory of the IMDI Corpus file and press ENTER

b. The new corpus is displayed here

3. To save the new corpus node permanently, do the following:

a. In the Metadata Descriptions Tree panel, click on the corpus node to select it.

b. Right-click on the selected corpus node.

A pull-down menu appears.
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Figure 5.9. Add to Bookmarks
i. Right-click on the selected corpus node

ii. Choose Add to Bookmarks from the pull-down menu

c. Choose Add to Bookmarks from the pull-down menu.

The Input dialog window appears.

Figure 5.10. Name for Bookmark
Enter a name for the bookmark

d. Enter a name for the bookmark and click OK.
The new corpus node is saved as a bookmark in the Bookmarks panel. Every time you restart the IMDI
Browser, you can access your corpus via the Bookmarks panel (see the separate manual 'IMDI Browser'
for details).
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Figure 5.11. An added Bookmark
The bookmark is added to the Bookmarks panel
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Appendix A. Recurring schemata
This appendix gives information about the recurring schemata Descriptions, Keys and Access.

A.1. Descriptions
A Descriptions schema contains a prose description that could serve as a reminder (to you or others) of the
circumstances of data collection. Descriptions schemata are not searchable.

The Descriptions schema is structured as follows:

Figure A.1. Description schema

1. The language in which the description is written (e.g., in English)
2. The available descriptions (e.g., there are 2 descriptions available, one in English, one in Goemai)
3. A prose description
4. A link to another file (e.g., to a *.pdf file containing the session protocol)
5. Click here to add another Descriptions schema, or to remove the highlighted schema

• Language

The language in which the description is written.

Either type in the language, or select the language from the pull-down menu.

Note

In earlier versions of the IMDI Editor, a code was entered into this field. Whenever you open
an IMDI file created with such an earlier version, this code is displayed (e.g., 'RFC1766:x-
sil-eng' instead of English). In newer versions of the Editor, the code is still stored in the
file itself (e.g., 'RFC1766:x-sil-eng') – but the user interface will display the code as a name
(e.g., as 'English').
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• Text

A prose description.

• Link

A link to an info file that contains further relevant information, e.g., a session protocol.

Note

Note for researchers working at the MPI for Psycholinguistics, Nijmegen: Please specify
only the name of the file – do not make use of the open folder icon to the right of the Link
field. And please save the info file as either a *.txt file, a *.pdf file or an *.html file.

You can create descriptions in different languages, e.g., one description in English (for the research
community) and one in the language under investigation (for the language community). In this case, you
have to add another Descriptions schema. Do the following:

• Click on the Add button to add a new schema.

• All schemata are displayed at the right of the Descriptions schema. They are listed under the language
name (as defined in the Language field).

– To access a schema, highlight it by clicking on it. It appears in blue color, and its content is displayed.
The content of all other schemata is hidden.

– To delete a schema, highlight it by clicking on it. Then click on the Remove button to delete it.

A.2. Keys
Keys contain user-defined information that is (a) project-specific, (b) not taken care of in the standardized
fields, and (c) meant to be searched. For example:

Figure A.2. Project-specific keys
Project-specific keywords for the actor J
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To add a key, do the following:

1. Click on the Add button. A new key will be added.

2. Specify a Key name. The name has to be a single word (e.g., "MetaDescriptionCreator"). Do not use
blank spaces.

3. Specify a Key value. Multiple words are allowed (e.g., "Student Assistant XY").

To delete a key again, highlight it by clicking on it. Then click Remove.

It is furthermore possible to add (project-specific) controlled vocabularies to a Keys schema, i.e., to have a
Keys schema display a pull-down menu containing predefined values (see also Section 1.2.3.3; and see the
IMDI CV-Editor manual for instructions on how to create controlled vocabularies).

To add a controlled vocabulary to a Keys schema, do the following:
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Figure A.3. Adding a controlled vocabulary to a Keys schema

1. Click on Add CV
2. The Vocabs overview window opens and displays all available vocabularies. If the needed vocabulary

is not displayed, add it by clicking on Add File … (for a locally-stored vocabulary) or Add URL …
(for a vocabulary stored on the Web).

3. Click on a vocabulary to select it.
4. Click on OK to add the selected vocabulary to the Keys schema.
5. A dialog window appears, asking you to choose the type of vocabulary (see also Section 1.5.2):

• 'vocabulary' (only one value can be entered) vs. 'vocabulary list' (more than one value can be entered);

• 'closed' (only values from the pull-down menu are accepted) vs. 'open' (alternative values can be
added)

6. Click on OK.
7. The controlled vocabulary is added to the Keys schema.
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A.3. Access
Access schemata group information about access rights to a resource.

Note

The different archives handle access rights differently. For example, many of the corpora
housed at the MPI for Psycholinguistics, Nijmegen, automatically deny access to media files,
written resource files, lexicon files and media tapes. But other archives may follow a different
policy.

Specify the access rights as follows:

Figure A.4. Specify access rights

1. Specification of the access rights
2. Owner and publisher of the resource
3. Date at which the access rights were set
4. Information about whom to contact in order to gain access
5. Description of the access restrictions

• Information

General information about access rights to the resource.

– Availability

Information about the availability of the resource. This field is not standardized yet – for the moment,
please enter a prose text (e.g., not available, available in 5 years, available to person XY).

– Date

Date at which the access rights were set. Please enter the date in the following format: YYYY-MM-DD,
e.g. 2000-12-30.

– Owner
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Name of the person/institution that owns the resource.

– Publisher

Name of the publisher who is responsible for the distribution of the resource.

• Contact

Information about whom to contact in order to gain access to the resource: Name, Address, E-mail address,
and Organisation.

• Descriptions

Prose description of the access restrictions.
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Appendix B. Release notes
Version 3.1

Now MAC users can use their standard editing functions for copy, cut and paste. We found however a bug
in WebStart 1.2.0 (the default version available under MacOS 10.2) that prevents the downloading of the
latest Xerces XML libraries. Users are advised either to use a more recent version of MacOS e.g 10.3 or to
use the 3.0 version of the IMDI-Editor.


